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Documentation Updates
The title page of this document contains the following identifying information:

l Software Version number, which indicates the software version.

l Document Release Date, which changes each time the document is updated.

l Software Release Date, which indicates the release date of this version of the software.

To check for recent updates or to verify that you are using themost recent edition of a document, go
to:

http://h20230.www2.hp.com/selfsolve/manuals

This site requires that you register for an HP Passport and log on. To register for an HP Passport
ID, go to:

http://h20229.www2.hp.com/passport-registration.html

Or click theNew users - please register link on the HP Passport log on page.

You will also receive updated or new editions if you subscribe to the appropriate product support
service. Contact your HP sales representative for details.
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Support
Visit the HP Software Support Online web site at:

http://www.hp.com/go/hpsoftwaresupport

This web site provides contact information and details about the products, services, and support
that HP Software offers.

HP Software online support provides customer self-solve capabilities. It provides a fast and
efficient way to access interactive technical support tools needed tomanage your business. As a
valued support customer, you can benefit by using the support web site to:

l Search for knowledge documents of interest

l Submit and track support cases and enhancement requests

l Download software patches

l Manage support contracts

l Look up HP support contacts

l Review information about available services

l Enter into discussions with other software customers

l Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also
require a support contract. To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.html

To findmore information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp
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Disclaimer for PDF Version of Online Help
This document is a PDF version of the online help. This PDF file is provided so you can easily print
multiple topics from the help information or read the online help in PDF format.

Note: Some topics do not convert properly to PDF, causing format problems. Some elements of
online help are completely removed from the PDF version. Those problem topics can be
successfully printed from within the online help.
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About this Guide
Welcome to theAssertion Editor User Guide. This guide explains how to use Assertion Editor as
part of HP EnterpriseMaps (HP EM).

This guide contains the following chapters:

l "Assertion Editor" (on page 9)

Provides an overview of themain features of Assertion Editor.

l "Getting Started" (on page 13)

Describes the installation of themain features, and shows you how to create an assertion
project in Assertion Editor.

l "Managing Assertions" (on page 17)

Explains how to create, download, edit, and compare assertions using Assertion Editor.

l "Validating and Publishing Assertions" (on page 24)

Shows how to test, publish, and resolve conflicts in assertions using Assertion Editor.

l "Deploying Assertions" (on page 26)

Shows how to build an Assertion extension project using Assertion Editor.

l "Customizing Assertions" (on page 30)

Explains how to customize the source type and add PM extensions in Assertion Editor.

l "Java Assertion Demo" (on page 32)

Demonstrates the creation of a custom assertion validator and its use with Assertion Editor and
HP EM.

l "Dialog Box Reference" (on page 36)

Dialog boxes reference.

l "Assertion Document Details" (on page 38)

Assertion document reference.

l "Integrating XQuery Function Libraries" (on page 50)

Integrating custom XQuery libraries with Assertion Editor.
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Chapter 1

Assertion Editor
HP EMWorkbench includes Assertion Editor, a set of features for use with the Policy Manager
component of HP EM. Assertion Editor enables you to create, edit, and delete assertions on any
number of Policy Manager servers. In addition, you can use Assertion Editor to test an assertion,
validating the assertion against a source document.

This chapter introduces Assertion Editor in the following sections:

l "Workbench Suite" (on page 9)

l "Overview" (on page 9)

l "User Interface" (on page 10)

Workbench Suite
HP EMWorkbench is a suite of editor tools enabling you to customize your deployment of HP EM.

Workbench consists of the following editor tools, distributed as a single Eclipse development
platform:

l Customization Editor

Customizes the underlying SOA DefinitionModel (SDM) within HP EM.

l Taxonomy Editor

Customizes the taxonomies used to categorize artifacts in HP EM.

l Assertion Editor

Customizes the conditions applied by your business policies within HP EM.

l Report Editor

Customizes report definitions for use with HP EM.

Overview
Assertions are the building blocks of policy. Each assertion checks a single condition of a policy,
returning a true or false result. In Policy Manager, one or more assertions are collected together to
form a technical policy. The technical policy is a set of assertions that fulfils amanagement
requirement.

HP EM provides tools for testing whether sources comply with the relevant policies.

Tomeet management requirements, a technical policy often needs a new assertion. Changing
requirements can also result in existing assertions becoming out of date. Assertion Editor is a tool,
built on the widely used Eclipse IDE, to simplify assertion creation and editing.

Assertion Editor makes working with assertions easy.

Use Assertion Editor to do the following:
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1. Create an assertion project.

For details, see the following sections:

n "Creating an Assertion Project File" (on page 14)

n "Downloading and Importing Assertions" (on page 15)

2. Create and manage assertions.

For details, see the following sections:

n "Creating Assertions" (on page 17)

n "Editing Assertions" (on page 17)

n "Deleting Assertions" (on page 22)

n "Comparing Assertion Versions" (on page 23)

3. Validate assertions before publishing.

For details, see "Testing Assertions" (on page 24).

4. Deploy assertions and manage conflicts.

For details, see the following sections:

n "Publishing Assertions" (on page 25)

n "Resolving Conflicts" (on page 25)

5. Customize assertions for use with Policy Manager.

For details, see "Customizing Assertions" (on page 30).

User Interface
The default perspective is split into a number of sections with menu options across the top.

The platform perspective consists of the following views:

l Project Explorer

The tree view of your assertion projects. For details, see "Project Explorer" (on page 10).

l Server Explorer

The view listing HP EM server connections toWorkbench. For details, see "Server Explorer" (on
page 11).

l Editor

The view showing the components of the assertion. For details, see "Editor View" (on page 12).

Project Explorer
The Project Explorer contains a hierarchical list of projects, the assertions in each project, and the
validation definitions in each assertion.

The Project Explorer contains additional context menu options enabling you to interact with a
running HP EM server. Right-click the project name or a particular assertion, and select HP EM to
view the options listed in the following tables:
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Option Function

Download
Assertions

Import Assertions from HP EM. For details, see "Downloading and Importing
Assertions" (on page 15).

Upload to
Server

Export assertions to the default HP EM server. For details, see "Publishing
Assertions" (on page 25).

Update
from Server

Update assertions from HP EM. For details, see "Editing Assertions" (on page
17).

Remove
from Server

Delete assertions from HP EM. For details, see "Deleting Assertions" (on page
22).

Upload To
Other
Server

Export assertions to a specified HP EM server.

Build
Extension

Create an assertion extension for HP EM containing all the assertions in your
project. For details, see "Building an Assertion Extension" (on page 26).

Project Context Menu Options

Option Function

Upload to
Server

Export an assertion to the default HP EM server. For details, see "Publishing
Assertions" (on page 25).

Update
from Server

Update assertions from HP EM. For details, see "Editing Assertions" (on page
17).

Remove
from Server

Delete the assertion from HP EM. For details, see "Deleting Assertions" (on page
22).

Upload To
Other
Server

Export an assertion to a specified HP EM server.

Build
Extension

Create an assertion extension for HP EM containing all the assertions in your
project. For details, see "Building an Assertion Extension" (on page 26).

Assertion Context Menu Options

Server Explorer
The Server Explorer displays the HP EM servers connected toWorkbench. The functionality is
shared by all theWorkbench editors.

Right-click a server in the Server Explorer to open the context menu described in the following
table.

Option Function

New Server Add a server for downloading assertions and taxonomies (Assertion Editor,
Taxonomy Editor, and Customization Editor).

Server Explorer Context Menu Options
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Option Function

Remove
Server

Delete a server from the Server Explorer.

Download
Taxonomy

Download a taxonomy from a server (Taxonomy Editor and Customization
Editor).

Download
Assertion

Download assertions from a platform server (Assertion Editor).

Download
Report

Download reports from a reporting server (Report Editor).

Properties View and edit the server name, URL, username, and password.

Editor View
The Editor view is themain feature of the Assertion Editor UI.

The pane is split into the following tabs:

l Overview Tab
TheOverview tab shows the components of the assertion.

The tab is divided into the following areas:

n General Information

Name of the assertion and its description.

n Implementation

List of implementations of validation logic and the artifact types to which they apply.

n Reference Template

Element used to reference this assertion from aWS-Policy document.

l Implementation Tab
The Implementation tab includes a list of implementations.

Highlighting an implementation opens the XQuery Definition Editor in the window beneath. For
details, see "Writing XQuery Definitions" (on page 19).

l Source Tab
The Source tab is an XML editor for editing the assertion.
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Chapter 2

Getting Started
This chapter describes the prerequisites for working with assertions in Assertion Editor. It contains
the following sections:

l "InstallingWorkbench" (on page 13)

l "SSL Configuration" (on page 14)

l "Creating an Assertion Project File" (on page 14)

l "Downloading and Importing Assertions" (on page 15)

Installing Workbench
HP EM is an Eclipse development platform distributed as a zip file, hp-em-workbench-1.00-
win64.zip.

Note: For supported platforms and known issues, see release-notes.doc alongside the
archive.

Note: HP EM requires Java SE Development Kit (JDK) 1.7.0 (64 bit version only) or higher. You
must include the path to this version of the JDK in the JAVA_HOME environment variable.

To Start HP EM Workbench:

l ExecuteWB_HOME/workbench/start.exe.

The first time you start Workbench, the welcome screen opens.

Select one of the options to open one of the editor tools, start a new editing project, or view the
documentation set.

You can return to the welcome screen from any of the editor tools by selectingHelp>Welcome
from themenu options.

By default, Workbench runs in 'normal' mode which prevents users from uploading system
taxonomies (IDs start with uddi:systinet.com:soa:model:taxonomies) and the Report
Editor .rptlibrary file to HP EM servers. If you need to work with system taxonomies or want
to upload the .rptlibrary file you can switchWorkbench into 'admin' mode.

Caution: Be extremely careful when working with system taxonomies, HP EM uses some hard-
coded values from system taxonomies, changing or removing themmay cause errors.

To Switch Workbench to Admin Mode

1. Open WB_HOME/configuration/config.ini with a text editor.

2. Add mode=admin to config.ini.

3. Restart Workbench.

Tip: HP EMWorkbench is memory-intensive. If you experience performance issues, HP
recommends increasing thememory allocation.
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To increase the memory allocation for HP EM Workbench:

1. Open WB_HOME/workbench/start.ini for editing.

2. Set these new values:

n -Xms128m

n -Xmx1024m

3. Save your changes.

4. Restart Workbench.

Tip: HP EMWorkbench downloads from HP EMmay time out. If you experience issues, HP
recommends increasing the time out.

To increase the time out for HP EM Workbench:

1. Open WB_HOME/workbench/start.ini (or eclipse.ini for stand-alone installation) for
editing.

2. Set the new value:

-Dorg.systinet.platform.rest.Client.timeout=200000

The value is in milliseconds with a default value of 120000 (2minutes).

3. Save your changes.

4. Restart Workbench.

SSL Configuration
By default, Workbench trusts all HP EM server certificates. Youmay want Workbench to verify HP
EM certificates.

To Verify HP EM Server Certificates:

l Add the following options to WB_HOME/workbench/start.ini:

-Dcom.hp.systinet.security.ssl.verifyCert=true
-Djavax.net.ssl.trustStore=USER_TRUSTSTORE
-Djavax.net.ssl.trustStorePassword=TRUSTSTORE_PASS
-Djavax.net.ssl.trustStoreType=TRUSTSTORE_FORMAT

If HP EM is configured for 2-way SSL, youmust provideWorkbench certificates to HP EM.

To Provide Workbench Client Certificates to HP EM:

l Add the following options to WB_HOME/workbench/start.ini:

-Djavax.net.ssl.keyStore=USER_KEYSTORE
-Djavax.net.ssl.keyStorePassword=KEYSTORE_PASS
-Djavax.net.ssl.keyStoreType=KEYSTORE_FORMAT

Creating an Assertion Project File
Towork with assertions, you need an Assertion Project. You can create any number of Assertion
Projects to help organize your work.

To Create an Assertion Project:
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1. Do one of the following:

n In theWorkbenchWelcome page, click Create Assertion Project.

n Click New to open the Select aWizard window, and select HP EM>Assertion
Project.

n From themenu, select File>New>Assertion Project.

n Press Alt+Shift+N, and then press R, to open the Select aWizard window. Then select HP
EM>Assertion Project.

The New Assertion Project dialog box opens.

2. In the New Assertion Project dialog box, enter the following parameters:

Parameter Definition

Project
Name

The name of your assertion project.

Namespace The namespace to apply to all assertions in the project.

Create from
Existing
Extension

Select this option if you want to create a new project from a previous
assertion extension. If selected, input the path or browse for the location of
the assertion extension.

Use Default
Location

If selected, Assertion Editor stores the project in your default workspace. If
unselected, input the path or browse for an alternative workspace.

3. Click Next to select or create a server.

Note: If no servers are currently defined, the dialog box continues to Step 5.

4. Do one of the following:

n Select Create a New Server, and click Next.

Continue to Step 5.

n Select Use an Existing Server, select the server from the list and input its credentials, and
then click Next.

Continue to Step 6.

5. In the New Server dialog box, add the required parameters, and then click Next.

6. Select the assertions to download from the server.

7. Select Download All Taxonomies to import taxonomies from HP EM tomake them available
for use as assertion parameters.

8. Click Finish.

Downloading and Importing Assertions
Using Assertion Editor, you can download assertions from anHP EM server to edit or test them.

You can download assertions in one of two ways:
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l When you create a project, as described in "Creating an Assertion Project File" (on page 14).

l From your local file system, at a later date.

Caution: If you import assertions containingmanual validation, Assertion Editor highlights the
manual validation as an error with amessage instructing you to remove it from the
assertion.

To Download Assertions:

1. Right-click the server containing the assertions you need in Server Explorer to open its context
menu, and select Download Assertions.

The Download Assertion dialog box opens.

2. Select the assertions to download, and click Next.

The Choose Location dialog box opens.

3. Select the project to add the assertions to, and click Finish.

To Import Assertions from a Local File:

1. Right-click the server containing the assertions you need in Server Explorer to open its context
menu, and select Import Assertions.

The Import Assertion dialog box opens.

2. Select the assertions to import, and click Next.

The Choose Location dialog box opens.

3. Select the project to add the assertions to, and click Finish.

The assertions are imported to your project.
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Chapter 3

Managing Assertions
This chapter explains how to work with assertions, as detailed in the following sections:

l "Creating Assertions" (on page 17)

l "Editing Assertions" (on page 17)

l "Deleting Assertions" (on page 22)

l "Comparing Assertion Versions" (on page 23)

Creating Assertions
In "Creating an Assertion Project File" (on page 14), you created an Assertion Project and looked at
how to download and import assertions. The following section explains how to create new
assertions.

To Create a New Assertion:

1. Do one of the following:

n Click New to open the New: Select aWizard dialog, and expandHP EM>Assertion,
and then, click Next.

n Select File>New>Assertion.

n Press Alt+Shift+N to open the context menu, and select Assertion.

The New Assertion wizard opens.

2. In the New Assertion wizard, enter the required parameters.

3. Click Finish to create the assertion.

4. Double-click the assertion in Project Explorer to open it in the Editor, and do the following:

l Add an implementation, as described in "Adding and Deleting Implementations" (on page 18).

l Test the assertion, as described in "Testing Assertions" (on page 24).

l Publish the assertion, as described in "Publishing Assertions" (on page 25).

Editing Assertions
The heart of Assertion Editor's functionality is the ability to edit assertions. To edit an assertion, you
must have a local copy.

Caution: If you are editing an assertion that also exists on a server, youmust update your local
copy before editing it. Editing a local assertion before updating it from the server can result
in a revision conflict. Assertion Editor warns you if this is the case. For details, see
"Resolving Conflicts" (on page 25).

To Update an Assertion from the Server:
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1. Right-click the assertion in Project Explorer to open its context menu.

2. Select HP EMt>Update from Server.

Themain functionality of editing assertions is described in the following sections:

l "Editing General Properties" (on page 18)

l "Adding and Deleting Implementations" (on page 18)

l "Writing XPath Definitions" (on page 19)

l "Writing XQuery Definitions" (on page 19)

l "Editing XQuery Definitions" (on page 20)

l "Editing Reference Templates" (on page 22)

Editing General Properties
General properties are the name and text description of the assertion. Changing the name in the
editor does not change the file name or reference template local name. These can only be changed
in the General Properties section of the Overview tab of the Assertion Editor View. For details, see
"Editor View" (on page 12).

Adding and Deleting Implementations
An implementation contains a resource type and the code used to validate that resource type. An
assertionmust contain one or more implementations.

To Add an Implementation:

1. In the Implementation field of the Editor view, click New.

The Define New Implementation wizard opens. For details, see "Define New Implementation
Wizard" (on page 36).

2. Do one of the following:

n To use a predefined resource type, select Select an Existing Type, select a resource type
from the list, and then click Next. Use filter to find a specific resource type and uncheck
Show common types only to list all available resource types.

Skip to Step 4.

n Tomanually define a new resource type, select Define New Type and then click Next.

3. Input a Namespace and Local Name, or click Load from file to use a document in your
assertion project, and then click Next.

4. Select the implementation type from the list and then click Finish.

To Delete an Implementation:

1. Open the Editor view and select theOverview tab.

Implementations in your project are displayed in the Implementation window.

2. To delete an implementation, select it and click Delete.
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After adding the implementation, open the Implementation tab of the Editor and edit the XQuery or
XPath definitions tomeet your needs. For instructions, see "Writing XPath Definitions" (on page 19)
or "Writing XQuery Definitions" (on page 19).

Writing XPath Definitions
After creating an implementation that uses an XPath validation handler, as described in "Adding and
Deleting Implementations" (on page 18), you need to write the XPath definition.

To Write an XPath Definition:

1. Open the Editor view and select the Implementation tab.

2. Import a sample XML document of the type to which the assertion applies.

3. In the XPath Definition Editor, under Load XML Template, select one of the following links:

n Click From Resource to load a sample XML document from your Assertion Editor project.

n Click From File to load a sample XML document from your local file system.

n Click From URL to load a sample XML document from theWeb.

The XML document appears in the XML Template tab.

To Add an XPath Expression:

1. Right-click the relevant line in the sample XML document to open its context menu.

2. Select Generate XPath Expression.

The XPath expression appears in the XPath Definition Editor field.

Note: You can have only one XPath expression for each implementation. An artifact passes
validation if at least one XML nodematches the XPath expression.

3. Modify the XPath expression in the XPath Definition Editor, if necessary.

4. If the XPath contains any unresolved namespace prefixes, an unresolved warning appears.

n If you receive a warning, go to Step 5.

n If you do not receive a warning, go to Step 8.

5. Click the unresolved prefix link.

TheManage prefix and namespace pane opens.

6. Define the namespace of the prefix, as follows:

n To add a namespace, click Add, and then enter the required parameters.

n To delete a namespace, select it and click Remove.

7. Click OK.

8. To test the XPath expression, click Test Expression.

The results of the test appear in the Test Results tab of the XPath Expression Editor.

For more information, see "XPath Assertions" (on page 46).

Writing XQuery Definitions
Assertion Editor incorporates syntax highlighting for writing and editing XQueries.
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To Write an XQuery Definiton:

1. Open the assertion in the Editor view, open the Implementation tab and click New.

The Define New Implementation dialog box opens, as shown in "Define New Implementation
Wizard" (on page 36).

2. To use a predefined source type:

n In the Predefined field, select the source type you need from the drop-down list.

n In the Dialect field, select XQuery from the drop-down list, and click OK.

3. Tomanually define a source type:

n Select theManual Define check-box.

n Enter the required parameters.

n In the Dialect field, select XQuery from the drop-down list, and click OK.

The XQuery Definition opens in the Editor view.

4. Edit the XQuery Definition, as described in "Editing XQuery Definitions" (on page 20), and click
Test Assertion.

If the assertion passes validation, you can now publish the assertion. For details, see
"Publishing Assertions" (on page 25).

If the assertion does not pass validation, you can resolve any problems. For details, see
"Resolving Conflicts" (on page 25).

For more information, see "XQuery Assertions" (on page 47).

Editing XQuery Definitions
Assertion Editor also supports external XML editors.

To use an external XQuery editor with Assertion Editor, youmust first add the Saxon extension to
the external editor:

l Folder

WB_HOME/plugins/com.systinet.tools.assertioneditor.lib_version-
number/lib/saxon-extensions/

l Extension

pm-extension-functions.jar

To Edit an XQuery Definition:

1. In Project Explorer, right-click the XQuery to open its context menu, select Open With, and
then select from the following options:

n Text Editor

To edit the XQuery with a plain text editor.

n System Editor

To edit the XQuery with an editor currently used by your system.
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n In-place Editor

To edit the XQuery with anOLE editor.

n Default Editor

To edit the XQuery with the default editor provided with Assertion Editor.

n Other

To edit the XQuery with an editor not previously defined.

2. Edit the XQuery as required and save your changes.

Instructions on how to add the Saxon extension to themost popular XML editors are given in the
following procedures:

To Set Up oXygen™ to Edit XQueries:

1. Open or create the XQuery file in oXygen.

2. Click Configure Transformation Scenario to open the Configure Transformation Scenario
wizard.

3. Select Execute XQuery, and click New to open the Edit Scenario pane.

4. In the Transformer field, select Saxon 8B.

5. Click Extensions to open the Extensions dialog box, and click Add to open the Add Extension
dialog box.

6. Type in or browse for the path to pm-extension-functions.jar.

7. Click OK in all wizard panes to save the transformation scenario.

When you open any other XQuery files, youmust always choose this transformation scenario and
then edit the XQuery file to force oXygen to rebuild it.

Note: This procedure was created for oXygen 8.1. Other versions can be used but some details
may differ.

To Set Up Stylus Studio™ to Edit XQueries:

1. Select Tools>Options to open theOptions dialog box.

2. ExpandModule Setting+XQuery>Processor Settings from the treemenu.

3. In theProcessor drop-down list, select Saxon 9.0.0.2, and then, click theUse as default
processor checkbox.

4. Click OK.

5. Select Project>Set Classpath and add the path to pm-extension-functions.jar.

To Open an XQuery in Stylus Studio™ from Assertion Editor:

1. In the Project Explorer of the Assertion Editor UI, right-click the XQuery.

2. Select Open With>System Editor.
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Editing Reference Templates
The referencing template defines the element used to reference an assertion from a Technical
Policy document. The template can include parameters which represent requirements whose
specific values might vary.

To Edit an Assertion's Reference Template:

1. Open theOverview tab in the Editor view.

2. In the Reference Template pane, enter the required parameters.

3. Do one of the following:

n To add a parameter, click New.

n To edit an existing assertion, highlight it, and then click Edit.

The Define Parameter wizard opens.

4. Input a name, description, select if the parameter is optional or required.

5. Do one of the following:

n Select Primitive type and the parameter type from the drop-down list.

n Select Taxonomy and input orBrowse for the relevant taxonomy.

Note: The available taxonomies depend on those imported from HP EMwhen you created
the project.

To Update Taxonomies:

i. Open the context menu for the assertion project and select Properties to open the
Project Properties dialog box.

ii. ExpandHP EM>HP EM and select Taxonomies to view the list of downloaded
taxonomies from the server.

iii. Click Download to update the taxonomies in the project.

6. Click OK.

To preview the reference template in a technical policy, click Preview assertion reference to open
the dialog box, and then enter example parameter values.

Deleting Assertions
If an assertion is no longer useful, you can delete it in one of the following ways:

To Delete a Local Copy of an Assertion:

l Right-click the assertion in Project Explorer to open its context menu, and select Delete.

Deleting a local copy of an assertion does not affect the version on the server.

To Delete an Assertion on a Server:

l Right-click the assertion in Server Explorer to open its context menu, and select Delete
Assertion.

Deleting the version of an assertion that is on a server does not affect any local versions.
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Alternatively, you can delete an assertion from the server directly from the Project Explorer. This
gives you the option of deleting the local copy at the same time.

To Delete an Assertion from the Server and the Local Copy:

1. Right-click the assertion in Project Explorer to open its context menu, and select HP
EM>Remove from Server.

2. When prompted, select one of the following:

n Also delete resources from local file system.

n Do not delete resources on local file system.

Comparing Assertion Versions
Assertion Editor uses the Eclipse Compare function to track version numbers, enabling you to roll
back an assertion to a previous version.

To Compare Versions of an Assertion:

1. Right-click the assertion in Project Explorer to open its context menu, and select Replace
with>Local History.

The Replace with Local History window opens.

Note: Changes to XQuery implementations do not appear in this window. XQueries are held in
separate, stand-alone files so they can be accessed by external XML editors. Use your
editor's revision control feature for XQueries.

2. Compare the versions.

3. Click Replace, if you want to replace the current version with the one to which you are
comparing it.
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Validating and Publishing Assertions
This chapter explains how to test assertions and deal with validation conflicts before publishing or
exporting them, as detailed in the following sections:

l "Testing Assertions" (on page 24)

l "Resolving Conflicts" (on page 25)

l "Publishing Assertions" (on page 25)

Testing Assertions
Before publishing an assertion, you can test it.

To Test an Assertion:

1. Double-click the assertion in Project Explorer to open it in the Editor.

2. Click Test Assertion.

The Run Configurations dialog box opens. For details, see "Run Configurations Dialog" (on
page 36).

3. Enter the required parameters, and click Apply to save the parameters, orRevert to roll back
the changes.

4. Click Run.

The test results appear in the Assertion Console view.

To Test a Different Assertion:

1. Click Browse.

The Select Assertion window opens

2. Browse for the required assertion.

3. Click OK.

4. Enter the required parameters, and click Run.

To Select Source Files for Testing an Assertion:

1. Click Add Documents to locate the source file to add,

2. Enter the required parameter values in the Parameters table, and then do one of the following:

n Click Apply.

n Click Revert to use themost recent parameter value.

For information about assertion reference templates, see "Editing Reference Templates" (on
page 22).

3. Click Run.
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Resolving Conflicts
Conflicts occur when there are differences between an updated local copy of an assertion and that
on the server. Assertion Editor notifies you of the conflict, and asks if you want to force the update
or publication.

Forcing an assertion to be updated overwrites any local changes that have beenmade. Forcing an
assertion to be published overwrites any changes that weremade to the version on the server.

The safest way to resolve such conflicts is to either cancel publication or update the assertion.

To Update a Conflicting Assertion:

1. Copy your local version of the assertion to a different location in Project Explorer.

2. Right-click the assertion to open its context menu, and select HP EM>Update Assertion.

A conflict warning appears.

3. Click OK to update the assertion.

Assertion Editor overwrites the local copy of the assertion with the version on the server.

Publishing Assertions
After writing, editing, and testing an assertion, you can publish it to an HP EM server.

Note: In Project Explorer, assertions that have not been published are indicated by a questionmark
(?). Assertions that have been changed locally since they were last synchronized with the
version on the server are indicated by a right arrow (>).

To Publish an Assertion:

l Right-click the assertion in Project Explorer to open its context menu, and select HP
EM>Upload to Server.

Assertion Editor connects to the server and attempts to publish the assertion.

To Select a Server that is not in the Project:

1. Right-click the assertion to open its context menu, and select HP EM>Upload to Other
Server.

The New Server wizard opens.

2. Follow the steps for adding a server, as described in "Creating an Assertion Project File" (on
page 14).

Caution: If changes weremade to the version on the server since you last synchronized, a conflict
warning appears that asks whether you want to force publication. For details on conflict
resolution, see "Resolving Conflicts" (on page 25).
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Deploying Assertions
This chapter explains how to deploy a set of assertions as an Extension Project, as detailed in the
following sections:

l "Building an Assertion Extension" (on page 26)

l "Applying Extensions" (on page 26)

l "Redeploying the EAR File" (on page 29)

Building an Assertion Extension
After publishing assertions, you can copy them to an Assertion extension.

Note: In Project Explorer, assertions that have not been published are indicated by a questionmark
(?). Assertions that have been changed locally since they were last synchronized with the
version on the server are indicated by a right arrow (>).

To Build an Assertion Extension:

1. Right-click the assertion project in Project Explorer to open its context menu, and expandHP
EM>Build Extension to open the location browser.

2. Enter a name for the extension project and browse for the location you want to save the project
to, and then click Save.

All assertions from the selected assertion project are copied to the Assertion extension.

Applying Extensions
You can extend HP EM by adding libraries or JSPs to the deployed EAR files, by modifying the
datamodel, by configuring the appearance of the UI, and by importing prepackaged data.

Extensions to HP EM come from the following sources:

l Customization Editor

Typical extensions created by Customization Editor contain modifications to the datamodel,
and possibly data required by the customization (taxonomies). They may also contain new web
components, whichmay include custom JSP and Java code.

Caution: If your extension contains new artifact types, HP EM does not create default ACLs for
them. Set default ACLs for the new artifact types in HP EM.

l Assertion Editor, Report Editor, and Taxonomy Editor

These extensions contain assertion, reporting, and taxonomy data only. They do not involve
changes to the datamodel.

The Setup Tool opens the EAR files, applies the extensions, and then repacks the EAR files.

Apply extensions according to one of the following scenarios:
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l Single-Step Scenario

The Setup Tool performs all the processes involved in applying extensions, including any
database alterations, as a single step.

Follow this scenario if you have permission to alter the database used for HP EM.

To Apply Extensions to HP EM in a Single Step:

a. Make sure that all extensions are in the following directory:

EM_HOME/extensions

The Setup Tool automatically applies all extensions in that directory.

Note: If you are applying extensions to another server, substitute the relevant home
directory for EM_HOME.

b. Stop the server.

c. Start the Setup Tool by executing the following command:

EM_HOME/bin/setup.bat(sh)

d. Select theApply Extensions scenario, and click Next.

The Setup Tool automatically validates the step by connecting to the server, copying the
extensions, andmerging the SDM configuration.

e. Click Next for each of the validation steps and the setup execution.

Note: This process takes some time.

f. Click Finish to end the process.

g. Deploy the EAR file:

o JBoss

The Setup Tool deploys the EAR file automatically.

If you need to deploy the EAR file to JBoss manually, see "Redeploying the EAR File"
(on page 29).

o Other Application Servers

Youmust deploy the EAR file manually.

h. Restart the server.

Caution: Applying an extension that modifies the SDMmodel may drop your full text indices.
EM_HOME/log/setup.log contains the following line in these cases:

Could not apply alteration scripts, application will continue with
slower DB drop/create/restore scenario. ... .

In these cases, reapply full text indices as described in the Installation and Configuration Guide.

l Decoupled DB Scenario

Database SQL scripts are runmanually. The Setup Tool performs the other processes as
individual steps that are executable on demand. This scenario is useful in organizations where
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the user applying extensions does not have the right to alter the database, which is done by a
database administrator.

Follow this scenario if the user who applies extensions does not have permission tomodify the
database.

To Apply Extensions and Modify the Database Separately:

a. Make sure that all extensions are in the following directory:

EM_HOME/extensions

The Setup Tool automatically applies all extensions in that directory.

b. Stop the server.

c. Start the Setup Tool by executing the following command:

EM_HOME/bin/setup -a

d. Select theApply Extensions scenario, and click Next.

e. Click Next, to execute the extension application, and exit the Setup Tool.

f. Provide the scripts from EM_HOME/sql to the database administrator.

The database administrator can use all.sql to execute the scripts that drop and recreate
the database schema.

g. Execute the Setup Tool in command-linemode to finish the extension application:

EM_HOME/bin/setup -c

h. Redeploy the EAR file:

o JBoss

The Setup Tool deploys the EAR file automatically.

If you need to deploy the EAR file to JBoss manually, see "Redeploying the EAR File"
(on page 29).

o Other Application Servers

Youmust deploy the EAR file manually.

Caution: In some specific circumstances (underscores and numbers in property names), extension
applicationmay fail because HP EM cannot create short enough database table names (31
character maximum for most databases).

The error in setup.log resembles the following:

[java] --- Nested Exception ---
[java] java.lang.RuntimeException: cannot reduce length of identifier

'ry_c_es_Artifact02s_c_priEspPty01Group_c_priEspPty01',
rename identifier elements or improve the squeezing algorithm

[java] at
com.systinet.platform.rdbms.design.decomposition.naming.impl.

BlizzardNameProviderImpl.getUniqueLimitedLengthName(
BlizzardNameProviderImpl.java:432)
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[java] at
com.systinet.platform.rdbms.design.decomposition.naming.impl.

BlizzardNameProviderImpl.filterTableName
(BlizzardNameProviderImpl.java:374)

If you do not require backwards compatibility with these older versions, you can change the table
naming algorithm.

To Change the Table Naming Algorithm:

1. Open EM_HOME/lib/pl-repository-old.jar#META-
INF/rdbPlatformContext.xml with a text editor.

2. In the rdb-nameProvider bean element, edit the following property element:

<property name="platform250Compatible" value="false"/>

3. Save rdbPlatformContext.xml

This solution only impacts properties with multiple cardinality. If the problem persists or you need to
preserve backwards compatibility, then review the property naming conventions in your extension.

Redeploying the EAR File
After using the Setup Tool to apply extensions or updates, youmust redeploy the EAR file to the
application server. For JBoss, you can do this using the Setup Tool.

To Redeploy the EAR file to JBoss:

1. Stop the application server.

2. Start the Setup Tool by executing the following command:

EM_HOME/bin/setup.bat(sh)

3. Select theAdvanced scenario, and click Next.

4. Scroll down, select Deployment, and then click Next.

When the Setup Tool validates the existence of the JBoss Deployment folder, click Next.

5. Click Finish to close the Setup Tool.

6. Restart the application server.
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Customizing Assertions
Assertion Editor incorporates predefined elements that are suitable for most use cases. However,
you can customize certain elements. Customization of assertions is described in the following
sections:

l "Customizing Source Type" (on page 30)

l "Adding Policy Extensions" (on page 30)

Customizing Source Type
When you define the implementation of an assertion, you can either select from a list provided by
Assertion Editor, or you can define your own source type.

To Manipulate Source Types:

1. From themenu, selectWindow>Preferences.

The Preferences wizard opens.

2. ExpandHP EM Assertion Editor, and select Source Type.

A table opens displaying source type names, local names, and namespaces.

3. Do one of the following:

n To create a new source type, click Add to open the New Source Type window. Enter the
required parameters, and click OK.

n To edit an existing source type, select it and click Edit to open the Edit Source Type
window. Enter the required parameters, and click OK.

n To delete an existing source type, select it and click Delete.

Adding Policy Extensions
You can extend HP EMwith custom-written validation handlers, in addition to the XQuery and
XPath handlers that are included in the distribution.

To Add a PM Extension to your Project:

1. Right-click the project in Project Explorer to open its context menu, and select Properties.

The Properties for HP EMwizard opens.

2. Select PM Extensions to open a list of PM extensions in the project.

3. Do one of the following:

n Click Add PM Extension to open the Select Extension window. Select the required
extension, and click OK.

n Click Add External PM Extension to open the Select PM Extension window. Browse for
the required extension, and click OK.
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After adding a PM extension to your Assertion Editor project, apply it to all relevant HP EM servers
with the Setup Tool.
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Java Assertion Demo
This demo shows how to create and use a custom assertion validator. You will learn how to:

l Create a custom assertion validator.

l Apply a custom assertion validator into HP EM as an extension.

l Create an assertion in Assertion Editor based on our validator.

l Publish the assertion to the Platform repository.

You can find the demo sources in EM_HOME\demos\policymgr\assertionvalidator. It
contains:

l An Eclipse project for developing a custom assertion validator (in the validator folder).

l An Assertion Editor project for developing a sample assertion (in the assertion folder).

l Demo data for testing our assertion validator (in the demodata folder).

The demo is divided into separate procedures, described in the following sections:

l "Creating the Assertion Validator" (on page 32)

l "Applying the Validator Extension" (on page 33)

l "Creating and Deploying the Assertion" (on page 34)

l "Testing the Assertion Validator" (on page 34)

Creating the Assertion Validator
A sample Eclipse project is available in EM_
HOME\demos\policymgr\assertionvalidator\validator. This project can be imported
into Eclipse as an existing project. It has the following structure:

l src/

A directory containing the Java sources.

l lib/

A directory containing external libraries used by assertion validator.

l resources/extension.xml

A Policy Manager extension definition file.

l build.xml

An Ant build file to build extension containing the validators.

The src folder contains a sample implementation of an assertion validator:
mycompany.validator.demo.ServiceNameValidator. This validator applies toWSDL
documents and checks whether the name of services defined inWSDL starts with the words
"dummy," "test," "sample," or "example."

HP EMWorkbench (1.00)Page 32 of 51



Assertion Editor User Guide
Chapter 7: Java Assertion Demo

The assertion validator class must implement bothmethods of the interface
org.systinet.policy.validation.AssertionValidator:

l QName getDialect()—Must return a QNamewhich will be used in assertions to invoke
this validator. Our example uses the QName {http://mycompany/validation}
ServiceNameValidator.

l void validate(ValidationListener listener, SourceCollection sources,
SourceType sourceType, ValidatedAssertion[] assertions,
ValidationContext context)—This is the validationmethod which is called when a
sourcemust be validated against an assertion using this validator. Our sample validator parses
the XML content of theWSDL document and checks each service name (under XPath
/wsdl:definitions/wsdl:service/@name) to see whether it starts with the unwanted
words or not.

Note: For more information about the Policy Manager's interfaces see the HP EM Javadoc.

To build an extension from your assertion implementation, you need an extension definition file,
which is available at resources/extension.xml. It contains a unique identifier (attribute uri)
which identifies the extension, the extension name (element name), and the list of contained
assertion validators (elements assertion-validator):

<?xml version="1.0"?>
<extension version="1.0" uri="mycompany.ext.demo">

<name>Demo Assertion Validators</name>
<assertion-validator

class="mycompany.validator.demo.ServiceNameValidator" />
</extension>

To build the extension you can use Eclipse to start an ANT build using build.xml or use the following
procedure:

To Build an Extension for the Assertion Validator:

1. Change your working directory to EM_HOME\demos\policymgr\assertionvalidator.

2. To get help run run.bat or run.sh.

3. Build the extension with the command run make.

4. Check the created extension in EM_
HOME\demos\p-
olicymgr\assertionvalidator\validator\dist\mycompany.ext.demo.jar.

Caution: If you want use an Eclipse project for this demo youmust define the EM_CLIENT_LIB
classpath variable in the Eclipse IDE. The EM_CLIENT_LIB variable must point to EM_
HOME/client/lib.

Applying the Validator Extension
After you create mycompany.ext.demo.jar, apply it to HP EM as an extension.

To Apply the Extension to HP EM:

1. Make sure the HP EM server is not running.

2. Copy EM_
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HOME\demos\p-
olicymgr\assertionvalidator\validator\dist\mycompany.ext.demo.jar
into EM_HOME\extensions.

3. Execute EM_HOME\bin\setup and select theApply Extensions scenario.

4. Start HP EM.

For details, see "Applying Extensions" (on page 26).

Creating and Deploying the Assertion
There is a sample project for Assertion Editor in EM_
HOME\demos\policymgr\assertionvalidaton\assertion.

You can use this sample project to create your own assertions. It already contains a demo
assertion named WSDLServiceNameIsNotDummy. Browse this assertion to see that it is
applicable toWSDLDocuments and implements the ServiceNameValidator created in
"Creating the Assertion Validator" (on page 32) (linked through EM_
HOME\demos\p-
olicymgr\assertionvalidator\validator\dist\mycompany.ext.demo.jar).

The XML definition of the assertion is automatically filled out according to the definition in assertion
validator (in themethod getDialect()):

<my:ServiceNameValidator xmlns:my="http://mycompany/validation"
xmlns:pm="http://systinet.com/2005/10/soa/policy"/>

After creating the assertion, deploy it. Or deploy the existing WSDLServiceNameIsNotDummy
assertion.

To Publish the Assertion to HP EM:

1. Open Assertion Editor.

2. Open the File menu and select Import>Existing Projects into Workspace and open the
demo project.

3. In the Server Explorer, open the context menu and define aNew Server pointing to your HP
EM server.

4. In the Project Explorer, open the Project context menu and select Properties>HP EM Server,
and select the server you just defined.

5. Publish the demo assertion from the Project Explorer.

Open theWSDLServiceNameIsNotDummy.asr context menu and select HP EM>Upload to
Server.

For more details, see the "Publishing Assertions" (on page 25).

Testing the Assertion Validator
In the previous sections you created and deployed an assertion validator and an assertion. The next
step is to use this new assertion in a validation for a business test case. To do this, you need to do
the following in HP EM:
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l Publish aWSDL containing a service element where the name attribute starts with Test. For
details, see the HP EMUser Guide.

l Create a Technical Policy applicable toWSDLs and add the WSDLServiceNameIsNotDummy
assertion to it.

l Create a Policy Report using artifact type, WSDL, and the new technical policy. For details, see
"How to Create Policy Reports" in the HP EMUser Guide.

l Execute the policy report and review the result. TheWSDLwith the service name attribute Test
must fail while all others should pass. For details, see the HP EMUser Guide.
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Dialog Box Reference
Each Assertion Editor input dialog is described in the following sections:

l "Define New ImplementationWizard" (on page 36)

l "Run Configurations Dialog" (on page 36)

Define New Implementation Wizard
The Define New ImplementationWizard enables you to add a new implementation of an assertion
either from an existing resource type or by adding a new one.

The wizard contains the following steps.

1. Enter general parameters to define the new implementation.

Parameter Definition

Define New Type Select this check-box tomanually define the resource type you
want to use.

Select an Existing
Type

Select a predefined resource type from the drop-downmenu.

Filter Text Use the input to reduce the list of resource types.

Show Common Types
only

De-select to show the full list of resource types.

2. If you are defining a new implementation resource type, youmust specify the namespace and
local name.

Parameter Definition

Namespace Namespace of the source type.

Local Name The local name of the source type.

Load from File Select to load a source document defining the source type.

3. Define the parameters for a new resource type. Select the implementation type from the
available options.

Run Configurations Dialog
Define parameters to test the assertion before publishing.
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Parameter Definition

Name The name you want to use for the test.

Assertion Browse for and select the assertion you want to test.

Source Add or remove a document to test against the assertion.

Parameters Enter the required parameters for the selected source.
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Assertion Document Details
“UDDI BE 01 Assertion XMLDocument” is the raw XML document of the UDDI BE 01 assertion.

UDDI BE 01 Assertion XML Document

<?xml version="1.0" encoding="UTF-8"?>
<pm:Assertion xmlns:pm="http://systinet.com/2005/10/soa/policy"

xmlns:up="http://systinet.com/2005/10/soa/policy/uddi"
xmlns:xs="http://www.w3.org/2001/XMLSchema">

<pm:Parameter Name="lang" Type="xs:string" XPointer="xpointer
(@RequiredLang)"/>
<!-- template of the instance of the assertion -->

<pm:Template>
<up:UDDI_BE_01 RequiredLang="en"/>

</pm:Template>
<pm:Validation SourceType="xmlns(ns=urn:uddi-org:api_v2)qname

(ns:businessEntity)"
xmlns:uddi="urn:uddi-org:api_v2"
xmlns:val="http://systinet.com/2005/10/soa/policy/validation">

<!-- the validation is implemented via xpath expression -->
<val:XPath>

count(/uddi:businessEntity/uddi:name[@xml:lang=$lang])&gt;0
</val:XPath>

</pm:Validation>
</pm:Assertion>

Assertion documents contain the following elements:

l pm:Assertion/pm:TemplateThis required element must contain exactly one child element,
which is a reference template of how this assertion looks as aWS-Policy document. If there are
namespace definitions here, they are included in the reference template. If the assertion has any
parameters, you can define default values for them in the reference template. If there are no
namespaces or parameters, the reference template can be in the form <name/>.

l pm:Assertion/pm:ParameterAn assertion in aWS-Policy document may contain
parameters including timeouts (inWS-ReliableMessaging), type of authentication, required
SOAP header elements, etc. This element gives a definition of such parameters, including the
type of the parameter and where the parameter can be found in an instance of the assertion. This
information is used both by the UI console and by policy validators.

l pm:Assertion/pm:Parameter/@NameThe name of the parameter. This namewill be
shown in the UI.

l pm:Assertion/pm:Parameter/@TypeType of the parameter's value.

l pm:Assertion/pm:Parameter/@TaxonomyA taxonomy with values that the parameter
can adopt. The taxonomy is specified using its tModelKey. This attribute is only required when
Type has the pm:taxonomy value (with pm being the
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xmlns:pm="http://systinet.com/2005/10/soa/policy namespace), otherwise it is
ignored (and optional).

l pm:Assertion/pm:Parameter/@XPointerIn the absence of a ValueXPointer
attribute, this attribute identifies the place of the parameter in the assertion's template (that is,
how the attribute can be obtained from an instance of the assertion). Only a simplified form of the
XPointer can be used.

The evaluation context for the XPointer is the root of the actual assertion. So, for example, b[1]
is the first "b" child of the assertion's element.

In this release, an XPath starting with "/" is interpreted to point to the root of the policy
document. This behavior will be changed, so do not use absolute XPaths.

l pm:Assertion/pm:Parameter/@ValueXPointer ValueXPointer identifies the place
of the parameter relative to the place identified by the XPointer attribute. When the parameter
is not set, the element referenced by the XPointer attribute is removed from the instance.
When the parameter is defined, its value is set to a place identified by the concatenation of the
XPointer and ValueXPointer values. The rationale for this attribute is that there are
assertions whose schema requires that either an attribute is set or the attribute's parent element
is missing.

l pm:Assertion/pm:Parameter/@OptionalThis attribute tells whether the parameter is
optional, that is, if it can be omitted from the assertion instance.

l pm:Assertion/pm:ValidationThe implementation, as described in "Implementations" (on
page 44).

The key components of the assertion, visible in both the UI and the XML document, are described
in the following sections:

l "Reference Templates" (on page 39)

l "Parameters" (on page 40)

l "Implementations" (on page 44), which includes the validation handler.

Reference Templates
The reference template defines what the assertion looks like instantiated as aWS-Policy document
(See the generic <pm:Template> element shown in “UDDI BE 01 Assertion XMLDocument”.). If
there is a namespace to be defined it is included in the reference template. If there are parameters,
you can define the default values they point to. If there is no namespace or parameter, the template
can be a simple empty tag, like <assertionName/>.

The UDDI BE 01 assertion reference template defines the up namespace. The assertion has one
parameter, lang, which points to the RequiredLang attribute. The reference template sets the
default value of this parameter, en. The actual XML of the reference template is:

<p:Template>
<up:UDDI_BE_01 RequiredLang="en"

xmlns:up="http://systinet.com/2005/10/soa/policy/uddi"/>
</p:Template>

Reference templates must obey the following rules:
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l The template namemust be unique.

l The templatemust be a complete and valid XML element, not a fragment.

l The template can carry a namespace. This is the case with theWS-I BasicProfile assertion
reference templates, such as <wsi:BP1004 xmlns:wsi="http://www.ws-
i.org/testing/2004/07/assertions/"/>

Parameters
Parameters represent requirements whose specific values may vary. They include such things as
timeouts, type of authentication, required SOAP header elements, and so on. The value referenced
by a parameter can differ between technical policies containing the parameter's parent assertion
because each technical policy contains its own instance of the assertion.

Using parameters lets the policy developer reuse assertions. The developer can set a different
required value for an assertion in each policy in which the assertion is used. Without parameters,
the developer would need a separate assertion for each required value.

“AssertionWith Parameter” is an assertion taken from a policy file (namespaces omitted for
brevity). Note the attribute RequiredLang with the value of "en". This attribute represents the
RequiredLang parameter. Its default value is "en" for English. This default value is specified in
the reference template (see "Reference Templates" (on page 39)) but the policy developer can
change this value in individual policy files. If the assertion developer does not specify the
parameter's default value in the reference template and does not set the parameter as optional, the
policy developer must set the parameter value when creating a technical policy with the
parameter's parent assertion.

Assertion With Parameter

<wsp:Policy xmlns:wsp="..."/>
<up:UDDI_BE_01 RequiredLang="en" xmlns:up="..."/>

</wsp:Policy>

A parameter definition has the following structure:

l pm:Parameter/@Name

Name of the parameter.

l pm:Parameter/pm:Description

Description of the parameter.

l pm:Parameter/@XPointer

Location of themodified attribute (expressed as an XPointer).

l pm:Parameter/@ValueXPointer

Location of themodified attribute (expressed as an XPointer). See below for details.

l pm:Parameter/@Optional

Optionality of the parameter (if it is optional, it might be left unfilled).

l pm:Parameter/@Type
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Type of the parameter's value. Supported values aremost of built-inW3C Schema data types
(see http://www.w3.org/TR/xmlschema-2/#built-in-datatypes):

n xs:string

n xs:boolean

n xs:float

n xs:double

n xs:duration

n xs:dateTime

n xs:time

n xs:date

n xs:gYearMonth

n xs:gYear

n xs:gMonthDay

n xs:gDay

n xs:gMonth

n xs:hexBinary

n xs:base64Binary

n xs:anyURI

n xs:QName

n xs:integer

n xs:long

n xs:short

n xs:byte

n xs:unsignedLong

n xs:unsignedInt

n xs:unsignedShort

n xs:unsignedByte

Where xs is the xmlns:xs="http://www.w3.org/2001/XMLSchema" namespace.

Also supported is the value pm:taxonomy (with pm being the
xmlns:pm="http://systinet.com/2005/10/soa/policy namespace), which
specifies that the parameter will take on values from the taxonomy specified by the
@Taxonomy attribute.

l pm:Parameter/@Taxonomy
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Taxonomy whose values the parameter adopts. Specified with the taxonomy tModelKey. The
attribute is required only when Type has the pm:taxonomy value, otherwise it is be ignored
(and optional). Actual parameter values are specified with keyValues in policy documents.

The following examples demonstrate the use of a taxonomy-based parameter and the
corresponding policy document:

Parameter with Taxonomy Type

<pm:Parameter Name="artifactType" Optional="true" Type="pm:taxonomy"
Taxonomy="uddi:systinet.com:soa:model:taxonomies:artifactTypes"
XPointer="xpointer(@artifactType)"
xmlns:pm="http://systinet.com/2005/10/soa/policy">

<pm:Description>Artifact type to restrict
applicability.</pm:Description>
</pm:Parameter>

Policy Document with a Taxonomy-Based Assertion

<wsp:Policy xmlns:ws="...">
<up:MyAssertion

arti-
fact-
Type="urn:com:systinet:soa:model:artifacts:soa:applicationArtifact"

xmlns:up="..."/>
</wsp:Policy>

The following assertion checks whether communication settings contain a connection timeout set
to at least 10 seconds. Additionally, the XMLSchema of this assertion specifies that either the
"value" must be present, or, to use the default value, the whole up:ConnectionTimeout
element must bemissing.

<wsp:Policy xmlns:wsp="..."/>
<up:Communication xmlns:up="...">

<up:ConnectionTimeout value="10000"/>
...

</up:Communication>
</wsp:Policy>

In this case, a single XPointer referencing the up:ConnectionTimeout/@value attribute is not
enough, because Policy Manager would not know that the whole element should be removed when
the value is not entered. Therefore the parameter is now described in two XPaths:

l Location of the element that should be removed when the value of the parameter is not set

l Location of the value within the element defined above

The location of the element is set in the XPointer and the location of the value within the element is
set in a ValueXPointer. For example, “Parameter with ValueXPointer Set at 5000”is a parameter
with the ValueXPointer set at 5000. This results in the policy document in “Policy Document with
ValueXPointer in Parameter Set to 5000”. By contrast, if the developer leaves the ValueXPointer
blank, the resulting policy document is “Policy Document with Empty ValueXPointer in Parameter”.

Parameter with ValueXPointer Set at 5000
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<p:Parameter Name="ConnectionTimeout" Optional="false"
Type="xsd:integer"

XPointer="xmlns(up=...)xpointer(up:ConnectionTimeout)"
ValueXPointer="xpointer(@value)"
xmlns:xsd="http://www.w3.org/2001/XMLSchema">

<p:Description>Connection timeout in milliseconds.</p:Description>
</p:Parameter>

Policy Document with ValueXPointer in Parameter Set to 5000

<wsp:Policy xmlns:wsp="..."/>
<up:Communication xmlns:up="...">

<up:ConnectionTimeout value="5000"/>
</up:Communication>

</wsp:Policy>

Policy Document with Empty ValueXPointer in Parameter

<wsp:Policy xmlns:wsp="..."/>
<up:Communication xmlns:up="...">
</up:Communication>

</wsp:Policy>

Table “XPointer Combinations and Results” shows the XML representations of various XPointer
and ValueXPointer combinations, for optional and required attributes, and whether the value is
defined or not. “XPointer” is a correctly defined XPointer.

Note:Only a simplified form of XPointer is recognized in the parameter definition. The rationale is
that in this context XPointer is used not only for retrieving data, but also for creating
parameters via the UI. This is not possible with general XPointers. The recognized XPointer
must have the following structure:

xmlns(prefix1=ns1)*xpointer({/{<prefix>:}?<localname>[<index>]}*)

XPointer Combinations and Results

Optional Value XPointer ValueXPointer Result in Policy Schema

Yes/No 'ABC' @P — <aP="ABC"/>

Yes — @P — <a/>

No — Prohibited

Yes 'ABC' b[1] @P <a><b P='ABC'/></a>

Yes — b[1] @P <a/> (XPointer is removed.)

Yes 'ABC' b[1] — <a><b>ABC</b></a>

Yes 'ABC' b[1] c[1] <a><b><c>ABC</c></b></a>

Yes — b[1] c[1] <a/> (XPointer is removed.)

XPointer

HP EMWorkbench (1.00)Page 43 of 51



Assertion Editor User Guide
Chapter B: Assertion Document Details

xmlns(soap=http://schemas.xmlsoap.org/soap/envelope/)
xmlns(myns=http://systinet.com/examples/foo)xpointer(soap:Envelope[1]
/soap:Body[1]/myns:Foo)

Implementations
An assertion has one implementation for each source type to which the assertion applies. Each
implementation is propagated into its own pm:Validation element. An implementation contains
the definition of the validation handler, in p:Validation/##other[1], and the type of artifact
which the assertion can be used to validate, in p:Validation/@SourceType.

Implementations use validation handlers if they do not specify manual validation. Validation
handlers are pluggable pieces of code that show Policy Manager how to validate a source
document. Validation handlers are usually XPath or XQuery expressions, in which case the source
code is included inside the implementation, but they can be custommade. Custommade validation
handlers are written in Java and the implementation references the Java class.

Validation handlers and source types are described in the following sections:

l "Source Type" (on page 44)

A description of all source types to which an implementationmay apply.

l "XPath Assertions" (on page 46)

XPath validation handlers.

l "XQuery Assertions" (on page 47)

XQuery validation handlers.

Source Type
The pm:Validation@SourceType attribute defines the type of artifact validated by the
assertion. SourceTypemust be a simplified XPointer identifying the root element of the resource
which the assertion validates. If this parameter is omitted, the implementation would apply to
sources of any type. However, for performance reasons it is better to map validation to a concrete
source type, as narrowly as possible.

SourceType can be set as one of the following:

l A general artifact type with the namespace usually defined in the pm:Validation element.
Please see Table “Source Types Applying to General Resources” for a list of these
SourceTypevalues and their associated artifacts and namespaces.

l An artifact type. These share the namespace
xmlns:a="http://systinet.com/2005/05/soa/model/artifact". A list of these
SourceType values and their matching artifact types is given in the following table.

Source Types Applying to General Resources

Resource SourceType value

Any resource xmlns(rest=http://systinet.com/2005/05/soa/resource)rest:resource

SOAP message xmlns(soap=http://schemas.xmlsoap.org/soap/envelope/)
soap:Envelope
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Resource SourceType value

UDDI v3 Business
Entity

xmlns(uddi=urn:uddi-org:api_v3)uddi:businessEntity

WSDLDefinition xmlns(wsdl=http://schemas.xmlsoap.org/wsdl/)wsdl:definitions

XML Schema xmlns(xsd=http://www.w3.org/2001/XMLSchema)xsd:schema

SourceTypes Applying Artifacts

Artifact Type SourceType Value

Agreement xmlns(a=http://systinet.com/2005/05/soa/model/artifact)
agreementArtifact

Application xmlns(a=http://systinet.com/2005/05/soa/model/artifact)
hpsoaApplicationArtifact

Business Policy xmlns(a=http://systinet.com/2005/05/soa/model/artifact)
businessPolicyArtifact

Business Service xmlns(a=http://systinet.com/2005/05/soa/model/artifact)
businessServiceArtifact

Consumption Request xmlns(a=http://systinet.com/2005/05/soa/model/artifact)
contractRequestArtifact

Contact xmlns(a=http://systinet.com/2005/05/soa/model/artifact)
contactArtifact

Contract xmlns(a=http://systinet.com/2005/05/soa/model/artifact)
contractArtifact

Conversation
Document

xmlns(a=http://systinet.com/2005/10/soa/policy/report)Conversation

Documentation xmlns(a=http://systinet.com/2005/05/soa/model/artifact)
documentationArtifact

HTTP Message
Document

xmlns(a=http://systinet.com/2005/10/soa/policy/report)Message

Person xmlns(a=http://systinet.com/2005/05/soa/model/artifact)
personArtifact

Policy xmlns(a=http://systinet.com/2005/05/soa/model/artifact)policyArtifact

Registry xmlns(a=http://systinet.com/2005/05/soa/model/artifact)
registryArtifact

Report xmlns(a=http://systinet.com/2005/05/soa/model/artifact)reportArtifact

SOAP Service xmlns(a=http://systinet.com/2005/05/soa/model/artifact)
webServiceArtifact
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Artifact Type SourceType Value

SLO xmlns(a=http://systinet.com/2005/05/soa/model/artifact)sloArtifact

Schema xmlns(a=http://systinet.com/2005/05/soa/model/artifact)
schemaArtifact

Taxonomy xmlns(a=http://systinet.com/2005/05/soa/model/artifact)
taxonomyArtifact

UDDI Channel xmlns(a=http://systinet.com/2005/05/soa/model/artifact)
uddiChannelArtifact

UDDI Entity xmlns(a=http://systinet.com/2005/05/soa/model/artifact)
uddiEntityArtifact

UDDI Registry xmlns(a=http://systinet.com/2005/05/soa/model/artifact)
uddiRegistryArtifact

WS-Policy xmlns(a=http://systinet.com/2005/05/soa/model/artifact)
wsPolicyArtifact

WSDL xmlns(a=http://systinet.com/2005/05/soa/model/artifact)wsdlArtifact

Web Application xmlns(a=http://systinet.com/2005/05/soa/model/artifact)webArtifact

XML Schema xmlns(a=http://systinet.com/2005/05/soa/model/artifact)
xmlSchemaArtifact

XML Service xmlns(a=http://systinet.com/2005/05/soa/model/artifact)
xmlServiceArtifact

XSLT xmlns(a=http://systinet.com/2005/05/soa/model/artifact)xsltArtifact

XPath Assertions
Example “XPath Expression” is an XPath that applies to UDDI business entities and returns every
name element whose langattribute is set to the same value as the value of the lang parameter. If
the XPath returns a non-empty list, the source document is considered to be valid against the
assertion. If the returned node list is empty, validation has failed.

XPath Expression

<val:XPath>
count(/uddi:businessEntity/uddi:name[@xml:lang=$lang])&gt;0

</val:XPath>

Youmust take the following points into account when writing XPath assertions:

l Namespace

The element val:XPath is the namespace context for the XPath expression. If you need to
define a prefix-namespacemapping, do it on this element or its ancestors.

l Type system
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The XPath engine used in this enforcer is the free version of the Saxon-B 8.5.1
XSLT/XPath/XQuery engine. Although this version does not contain XML Schema parsing, it
still checks for type conformance. For example, if you need to check that the value of attribute
"xyz" is greater than 5, include in your XPath expression:

xs:integer(@xyz) > 5

If you fail to retype to integer, the XPath expression will never be fulfilled and no warning will be
returned.

l Parameter type

In this release, assertion parameters are always passed as strings, regardless of the schema
type written in the parameter definition. For this reason you have to explicitly cast the parameter
in numerical comparisons. For example, the following XPath expression would be used in an
assertion which checks that themessage's body has at most a given number of elements
(defined as a parameter namedMaxElements):

count(soap:Body//*) <=xs:integer($MaxElements)

XQuery Assertions
XQuery expression can be represented as follows:

XQuery Expression

<val:XQuery>
declare namespace rest="http://systinet.com/2005/05/soa/resource";
declare namespace

a="http://systinet.com/2005/05/soa/model/artifact";
declare namespace

p="http://systinet.com/2005/05/soa/model/property";
declare namespace

val="http://systinet.com/2005/10/soa/policy/validation";
declare variable $metadata.source.url external;
if (exists

(rest:r-
esource/rest:descriptor/a:businessServiceArtifact/p:productionStage))
then

val:assertionOK()
else

val:assertionFailed(concat('This service is not assigned a
category from a lifecycle taxonomy. ',

'To fix this problem, go to <a href="', $metadata.source.url,
'&view">the service</a>, ',

'click on "Edit" and assign the category.'))
</val:XQuery>

The XQuery in “XQuery Expression” comes from the Service Supports Lifecycle assertion. The
XQuery applies to business services and checks that each service has a lifecycle stage assigned
to it. In the HP EM 2 use of XQueries, the assertionOK function is called only one time per tested
artifact if the artifact passes validation, whereas if the artifact fails, the assertionFailed
function is called for each individual violation. For the XQuery in “XQuery Expression” there is no
logical need to call assertionFailedmore than once, since the artifact either has one lifecycle
stage or none at all. In “XQuery ReportingMultiple Failures”, the XQuery checks each include
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and import element andmakes sure they use relative references. The assertionFailed
function is called for each element that does not use relative references.

XQuery Reporting Multiple Failures

declare namespace xs = &quot;http://www.w3.org/2001/XMLSchema&quot;;
declare namespace

val=&quot;http://systinet.com/2005/10/soa/policy/validation&quot;;
let $errors :=
for $el in //xs:*[local-name() = 'include' or local-name() =

'import'] where ($el/@schemaLocation and contains($el/@schemaLocation,
':'))

return
val:assertionFailed(concat('This xs:', local-name($el), ' uses

absolute reference to another schema.'), $el)
return
if (empty($errors)) then

val:assertionOK()
else

()

Note:Namespaces are not propagated from parent elements but defined via standard XQuery
declarations.

Together with the source document, XQuery assertions can be called with additional parameters.
For example, these parameters can be used by the assertion to perform additional checks or output
the location of the problem back to the user. The parameters are added to the XQuery expression of
the assertion. A metadata parameter is shown in “XQuery Expression”.

Parameter name Description

metadata.source.url The URL of the source of validation. In the case of HTTP
request/response, this points to the request/response
message. For one-way messages, WSDL documents etc. it
points to the resource being validated.

metadata.description.url The URL of the associated description document (for
example, WSDL associated to a log of messages).

metadata.source.is.subdocument Detects subdocuments. Returns "false" if document is
standalone, "true" if document is part of a larger document.

If you want to write a new XQuery assertion or modify an existing one, follow these guidelines:

l The XQuery engine used in this enforcer is the free version of the Saxon-B 8.5.1
XSLT/XPath/XQuery engine. Although this version does not contain XML Schema parsing, it
still checks for type conformance. For example, if you need to check that the value of attribute
"xyz" is greater than 5, write:

xs:integer(@xyz) > 5

Failing to do so, the XQuery expressionmight never be fulfilled. If this happens, no warning will
be returned.

l In this release, assertion parameters are always passed as strings, regardless of the schema

HP EMWorkbench (1.00)Page 48 of 51

http://www.saxonica.com/
http://www.saxonica.com/
http://www.saxonica.com/


Assertion Editor User Guide
Chapter B: Assertion Document Details

type written in the parameter definition. Because of this youmust explicitly cast the parameter in
numerical comparisons. For example, the following expression would be used in an assertion
which checks that themessage's body has at most a given number of elements (defined as a
parameter named MaxElements):

count(soap:Body//*) <= xs:integer($MaxElements)
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Appendix C

Integrating XQuery Function Libraries
You can integrate a user-defined XQuery Library into Assertion Editor.

To Integrate an XQuery Function Library:

1. You JAR file must have the following structure:

n your-lib.jar

o META-INF

o your-XQueryContext.xml

o com

o your-class

your-XQueryContext.xml shouldmatch the following structure:

<?xml version="1.0" encoding="UTF-8"?>
<beans xmlns="http://www.springframework.org/schema/beans"

xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xmlns:aop="http://www.springframework.org/schema/aop"
xmlns:jee="http://www.springframework.org/schema/jee"
xmlns:lang="http://www.springframework.org/schema/lang"
xmlns:tx="http://www.springframework.org/schema/tx"
xmlns:util="http://www.springframework.org/schema/util"
xmlns:context="http://www.springframework.org/schema/context"
xsi:schemaLocation="http://www.springframework.org/schema/beans
http://www.springframework.org/schema/beans/spring-beans.xsd
http://www.springframework.org/schema/aop
http://www.springframework.org/schema/aop/spring-aop.xsd
http://www.springframework.org/schema/jee
http://www.springframework.org/schema/jee/spring-jee.xsd
http://www.springframework.org/schema/lang
http://www.springframework.org/schema/lang/spring-lang.xsd
http://www.springframework.org/schema/tx
http://www.springframework.org/schema/tx/spring-tx.xsd
http://www.springframework.org/schema/util
http://www.springframework.org/schema/util/spring-util.xsd
http://www.springframework.org/schema/context
http://www.springframework.org/schema/context/spring-

context.xsd">
<context:annotation-config/>
<!--STM Lifecycle Policies: XQuery extension for Policy

Manager,
depends on lifecycle API-->

<bean id="your-bean-id" class="your-class-XQueryExtension"

HP EMWorkbench (1.00)Page 50 of 51



Assertion Editor User Guide
Chapter C: Integrating XQuery Function Libraries

scope="singleton"/>
</beans>

2. Open AE_LIB/META-INF/eclipseBeanRefContext.xml in a text editor.

Note: AE_LIB refers to WB_
HOME/plugins/com.systinet.tools.assertioneditor.lib_1.0.n.xxx for
standalone version or WB_
HOME/dropins/sw/eclipse/plugins/com.hp.systinet.tools.ae.lib_
1.0.n.xxx for the plugin version.

3. Add your mapping file to the constructor-arg element:

<beans xmlns="http://www.springframework.org/schema/beans"
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xsi:schemaLocation="http://www.springframework.org/schema/beans
http://www.springframework.org/schema/beans/spring-beans.xsd">

<bean id="com.hp.soa.systinet"

class="com.hp.systinet.spring.ClassPathXmlApplicationContext">
<constructor-arg>

<list>
<value>classpath*:META-INF/${mapping_file.xml}</value>
<value>classpath*:META-INF/pmContext.xml</value>
<value>classpath*:stmContext.xml</value>

</list>
</constructor-arg>

</bean>
</beans>

4. Add the XQuery library to the AE_LIB/lib/ folder.

5. Modify AE_LIB/META-INF/MANIFEST.MF to set the Eclipse classpath. Add the XQuery
library to the Bundle-ClassPath item. For example, lib/lifecycle-xquery.jar.

6. Restart Workbench with command, start.exe -clean.
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